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1. Introduction 
This document is an end-user guide to using the Bensikin application, and a brief developer-oriented presentation of 
the application’s architecture. 

 

2. Application’s context: Contexts and Snapshots.  
A snapshot is, as said in the name, a view of the equipments (attributes) at a precise instant. A snapshot is based on a 
context, that is a filter to only view a specific list of attributes. A context is described by meta-data (author, 
description, etc…), so that user can know which context is used what for. 

A snapshot can also be used to reset equipments to the values of this snapshot. 

 

3. Application’s description and goals 

3.1. Application’s goals 
Bensikin allows the user to define contexts and snapshots. Snapshots be saved as files and modified. 

Bensikin v1.0 is ready for multi-user functioning, which has for consequence the need to define profiles. A profile 
is a way to map a user with a working directory. An important conséquence of this is, that 2 different user must 
not use the same working directory, or you may encounter crashes. A profile has a name and a path to a 
working directory. 

Bensikin is thus naturally divided (both in functionalities and display) in three parts: 

• The profile part, that is an introduction to the rest of the application 

• The context part 

• The snaphot part   

 

3.2. A first look to Bensikin 
 

Figure 1: Bensikin Profile Manager 

 
 

Profile Selection Combo Box
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Figure 2: Bensikin Main Panel 

 
 

• The Bensikin Profile Manager is here to manage profiles which means : 

o Creating a new profile 

o Deleting an existing profile 

o Launching application with a profile chosen in a list 

• The Bensikin Profile Manager also allows you to quickly manage sessions 

• The Context Control Panel is where user can manage contexts, which means creating, loading and 
modifying contexts, and launch snapshots based on the defined contexts. 

• The Snapshot Control Panel is where user can manage snapshots, which means saving snapshots in files, 
loading snapshots from database and files, temporaly modify snapshots’ attributes values and set 
equipment with defined snapshots (whith or without modifying snapshots) or a subpart of them. 

• The Logs panel displays success/failure messages to the user upon realization of an action. 

• The Menu and the Tool bar are for actions shortcuts and application’s options. 

 

 

 

 

 

 
 
 
 
 
 
 
 
 

Snapshot Control panel 
 

                                         Application’s Logs panel

 
 
 
 
 
 
 
 
 

Context Control panel 

                         Menu and Tool bar 
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4. Profile Manager 
The Figure 1: Bensikin Profile Manager presents the Profile Manager Interface, on application start. With this 
manager, you can create a new profile, or delete or use an existing one. 

To quit the application, simply click on  or  button.  

Existing profiles are listed in the Profile Selection Combo Box, which you can reload by clicking on 

 button (if you think that someone could have modified it by creating a new profile or deleting 
an existing one, for example). 

 

4.1. Creating a new profile 
To create a new profile, click on the button  (At the bottom left of the panel). A new diaalog will 
appear, as following : 

Figure 3: Creating a new profile 

 
In this new dialog, you will have to enter the name of your new profile and the path of the application working 

directory for this profile. If you prefer, you can browse for the path by clicking on the  button. Then, 
a classic browsing dialog will be displayed, in which you can choose the directory. When both fields (“Name” 

and “Path”) are fullfilled, click on  button to validate your new profile and add it in the list of existing 

profiles. If you click on  or  button, you go pack to the first dialog, as presented in Figure 1: 
Bensikin Profile Manager, and nothing is done. 

 

4.2. Deleting an existing profile 
To delete an existing profile, first select the profile in the Profile Selection Combo Box, as following : 

Figure 4: Profile Selection 

 

When the profile is selected, click on  button to delete it. If you do so, you won’t be 
able to use this profile any more (and no other user either), because the profile is definitely removed from list. 

The profile deletion doesn’t involve the corresponding Bensikin directories deletion.  
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4.3. Launching application with an existing profile 
To launch application with an existing profile, first select the profile in the Profile Selection Combo Box, as 
presented in Figure 4: Profile Selection. 

Then, click on  button, and you will reach the application main panel configured with this profile 
(the profile name is displayed in frame title, see Figure 2: Bensikin Main Panel) 

 

4.4. Sessions 
With the Bensikin Profile Manager, you have the possibility to enable or not multi sessions. To do so, you have to 
select or unselect the check box: . It only 
affects the Bensikin you just started to run. 

The expected behaviour is the following: 

• If no other Bensikin is launched on the profile you selected, checking or unchecking the check box will 
not have any effect. Bensikin will just run with the selected profile and work in its directory. 

• If another Bensikin is already running with the selected profile 

o If  the checkbox is unchecked, then a dialog will appear to warn you about the fact that another 
Bensikin is running. Closing this dialog will send you back to the profile manager. 

Figure 5: Multi sessions disabled 

 
 

o If  the checkbox is checked, then a dialog will appear to warn you about the fact that another 
Bensikin is running. Closing this dialog will continue run Bensikin. However, Bensikin will 
run in a sub directory of the profile working directory, and you will not be able to retrieve this 
session on Bensikin next start.  

Figure 6: Multi sessions enabled 
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5. Context Management 
 

This section describes how to control contexts with Bensikin. A context is a list of attributes on which you can make a 
snapshot. A context has an ID and a creation date, both defined by the database. A context also has a name, an author, 
a reason and a description. The reason usually describes why the context was created (example: because of an incident 
or in order to set some equipments), whereas the description is here to have an idea of what kind of attributes you will 
find in this context. 

Contexts are managed in the context control panel : 

 
Figure 7: Context Control Panel 

 
 

 

 

 

 

 

 

 
 

Context List sub panel 

 
 
 

Context Details sub panel 
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5.1. Creating a new context 
To create a new context, click on the “new” icon in toolbar ( ), or choose he option to make a new context from 
“File” menu or “Contexts” menu : 

    
 

You also are ready to make a new context at application first start or by clicking on the “reset” icon ( ) : 
Figure 8: Application first start 

 

The difference between the “reset” icon( ) and the “new” icon( ) is, that the “reset” icon will clear every 
panel, whereas the “new” icon will only clear the snapshot list and the Context Details sub panel. 
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5.1.1. Classic way (tree) 
 

The tree on the left side of the Context Details sub panel allows you to check for available attributes. The one 
on the right side represents your context attributes.  

To add attributes in your context browse the left tree, select attributes (represented by the icon  ), and click 
on the arrow ( ) to transfer them to the right tree.  

To remove attribues from your context, select them in the right tree and click on the cross ( ). 

Finally, fill the context meta data (Name, Author, Reason and Description) in the corresponding fields (Note 

that filling the fields activates the “register” button ). 

Then, you can save your context in database by clicking on the “register” button .  

Doing so will deactivate the “register” button and activate the “launch snapshot” button . 

You can save your context in a file using the “save”icon . 
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5.1.2. Alternate way (table) 

To select this alternate way, go to “tools” menu and select “options” . 

Then select the “context” tab and click on the “table” radio button. 
Figure 9: Options - Context Tab 

 
Click on the “ok” button. The context panel now has the “table selection mode”. 



Synchrotron Soleil  Bensikin Manuel 
 

“Reference”  Last Update : 8 February 2007 Page 12/26 
 

Figure 10: Bensikin with Context Table Selection Mode (new Context) 

 
• Attribute selection and automatic attributes adding: 

o Choose a Domain. This refreshes the list of possible Device classes for this Domain. 
o Choose a Device class.  This refreshes the list of possible Attributes for this Domain and Device 

class. 
o Choose an  Attribute and press OK : 
o All Attributes  

 with the selected name 
AND 
 belonging to any Device of the selected Class and Domain 

   are added to the current Context’s list of attributes. 
 
All new attributes are light red until the Context is registered. 
 

• Line level sub-selection of loaded attributes: 
Each attributes is initially checked, but this check can be removed by the user. When the user clicks on 
“validate”, all unchecked attributes will be removed from the current Context. 
 

o Click “All” to select all lines 
o Click “None” to select no lines 
o Highlight lines in the list (CTRL and SHIFT are usable), then click “Reverse highlighted” to reverse 

the checked/unchecked status of all highlighted lines. 
 

As for the classic way, you will have to fill the meta data fields and register your context in database by clicking on 

the “register” button . 

 
Attributes filtering box 

Line-level selection buttons 

 
List of Context attributes  

(new attributes are light red) 
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5.2. Modifying an existing context 
As a matter of fact, you can not really “modify” a context. What you can do is to create a new context with its 
informations (attributes and meta data) based on another one. 

The very difference is in alternate mode, where former attribute are in white and new ones in light red : 
Figure 11: Bensikin with Context Table Selection Mode (modified Context) 

 
The “register” button changed a little too : its text is “Register this context” instead of “Register this new 
context”, as you can see on the figure above. 
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5.3. Loading a context 
There are 2 ways to load a context :  

• Load it from the database 
• Load it from a file 
In both cases, loading a context will apply a quick filter on the snapshot list, so you can see the snapshots about 
this context that have been created this day (the day when you load the context). 

5.3.1. Loading a context from database 
In the “Contexts” menu, choose “load” then select “DB”:  

 
A dialog will then appear to allow you to filter the list of contexts in database following different criteria : 

Figure 12: Database Context Filter Dialog 

 

Select no criterion to search for all contexts present in database. Click on the  button to apply the 
filter. The list of corresponding contexts will then appear in the Context List sub panel, as shown in Figure 7: 
Context Control Panel. Double click on a context in table to load it and see its details in the Context Details 
sub panel (See Figure 7: Context Control Panel).  

If there are too many contexts in the list, you can remove some contexts from list (not from database) by 
selecting them in list and clicking on the cross on the top right corner of the list ( ). 

 

5.3.2. Loading a context from file 
In the “Contexts” menu, choose “load” then select “File”, or in “File” menu choose “load” then select 
“Context”: 

   
A classic file browser will appear. Search for your “.ctx” file and select it to load the corresponding context in 
the Context Details sub panel (See Figure 7: Context Control Panel). 
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5.4. Printing a context 
Once you have context ready, click on the “print” icon ( ) and select “context”: 

 
The classic print dialog will then appear. Validate your print configuration to print an xml representation of your 
context. 

5.5. Saving a context 
Once you have context ready, click on the “save” icon ( ) and select “context”: 

 
You also can go to menu “Contexts” and click on “save”, or go to menu “File”, select “Save” and click on 
“Context”. 

   
Then, the behaviour is “Word-like”. This means that if this is the first time you save this context, you will see the 
classic file browser to choose where to save your context, whith which file name. However, if not, it will 
automaticly save in the corresponding file. If you want to save in another file, you have to go to “File” menu, 
select “Save As” and click on “Context” , or go to “Contexts” menu and click on “Save As” 
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6. Snapshot Management 
This section describes how to control snapshots with Bensikin. A Snapshot is a view of your equipment at a precise 
date, view based on a context. A Snapshot has an ID, a creation date (Time), and a comment to describe it (which can 
be left empty). 

Snapshots are managed in the snapshot control panel : 
Figure 13: Snapshot Control Panel 

 
 

 

 

 

 

 

 

 

 

 

 
 
 

Snaphot List sub panel 

 
 
 
 

Snapshot Details sub panel 
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6.1. Creating a new snapshot 
To create a new snapshot, first select a valid context in the context control panel (see Figure 7: Context Control 

Panel). Then click on the button . The corresponding snapshot is added in the list of snapshots 
in the Snaphot List sub panel. 

 

6.2. Loading a snapshot 
There are 2 ways to load a snapshot :  

• Load it from the database 
• Load it from a file 
 

6.2.1. Loading a snapshot from database 
Loading a snapshot from database consists in adding this snapshot in the list of snapshots in the Snaphot List 
sub panel. 

As you can see in Figure 13: Snapshot Control Panel, the Snaphot List sub panel allows you to filter 
snapshots from database to find the snapshot you want to load. However, have in mind that this filter is 
“context dependant”, which means that the snapshot that will appear in the list by clicking on the “filter” 

button ( ) are the one that correspond to your filter criteria AND the selected context in the Context 

Control Panel. If the filter is cleared (which you can obtain by clicking on the button ), 
you will search for all the snapshots in database that correspond to the selected context. 

 

6.2.2. Loading a snapshot from file 
In the “Snapshots” menu, choose “load” then select “File”, or in “File” menu choose “load” then select 
“Snapshot”: 

   
A classic file browser will appear. Search for your “.snap” file and select it to load the corresponding snapshot 
in the Snapshot Details sub panel (See Figure 13: Snapshot Control Panel). 
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6.3. Editing a snapshot 
To edit a snapshot, double click on the snapshot you want to edit in the snapshot list (in the Snaphot List sub 
panel). This will open a new tab about this snapshot in the Snapshot Details sub panel, tab named by this snapshot 
ID. If you load a snapshot from file, the name of the tab is the name of the file. To differenciate snapshots loaded 
from file and the ones loaded from database, the snapshot loaded from file tabs have the icon . 

6.3.1. Setting equipments with a snapshot 
A snapshot allows you to set equipments with its attributes write values. You can choose which attributes will 
set equipments, and which not, by selecting or unselecting the corresponding check box in the column “Can 
Set Equipment” (See Figure 13: Snapshot Control Panel). By default, every attribute is selected. If you 
unselect some attributes, an icon  will appear in tab title to notify you that these attributes will not set 
equipments. You can quick select/unselect all the attributes by clicking on  and  buttons.When you 

are ready to set equipments with the selected write values, click on the button . 

You also can modify the write value before setting equipments by editing it in the table. If you do so, the 
value becomes red and a  icon appears to warn you about the fact that you made modifications in this 
snapshot (these modifications will not be saved in database, they are just here to set equipments). 

Figure 14: Modified snapshot 
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6.3.2. Snapshot comparison 
There are 2 ways to compare snapshots: 

• Compare a snapshot with another one: 
To do so, select a tab in Snapshot Details sub panel (See Figure 13: Snapshot Control Panel). Click on 
button . You will see the tab title of this attribute appear in the field “1st snapshot”. Select 
another tab and click again on  button to put this attribute tab title in the field “2nd 
snapshot”. Click then on  button to see the comparison between these 2 snapshots. 

Figure 15: Snapshot Comparison - full table 

 
You can print this comparison table by clicking on “Print “ button. 
 

• Compare a snapshot with current state:  
To compare a snapshot with current state, set this snapshot as “1st snapshot”, as explained above, and 
leave the “2nd snapshot” empty. Note that once the 1st snapshot is selected, you only can update the 2nd 

snapshot or clear the comparison selection. To do so, click on the button . What is 
hidden behind this is a creation of a snapshot, named “BENSIKIN_AUTOMATIC_SNAPSHOT”, and 
you compare this snapshot with your snapshot. Have in mind that this automatic snapshot is registered in 
database. So, in the comparison table, the current state will appear as the second snapshot with the name 
“Current state” (red block in the comparison table). 

 

6.3.3. Snapshot Details copy 
As you can see in Figure 13: Snapshot Control Panel, snapshots are detailed in a table. You can copy this 
table to clipboard as a text-CSV formated table by clicking on  button. If you want to see this text result 
and maybe filter it (like removing lines), click on  button. You wiil see the text appear in a dialog. 

Figure 16: Snapshot Edit Clipboard Dialog 

 
Modify the text as you want and click on “Validate clipboard changes” to copy it to clipboard and close the 
dialog.  

You can modify the column separator in options. 

 

6.3.4. Modifying a snapshot comment 
Once your snapshot details are loaded, click on  button to modify its comment (and save it in 
database or file). 

 
 
 

Difference Block 

 
 
 

1st Snapshot Block 

 
 
 

2nd Snapshot Block 
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6.4. Printing a snapshot 
Once you have context ready, click on the “print” icon ( ) and select “snapshot”: 

 
The classic print dialog will then appear. Validate your print configuration to print an xml representation of your 
snapshot. 

 

6.5. Saving a snapshot 
Once you have context ready, click on the “save” icon ( ) and select “snapshot”: 

 
You also can go to menu “Sontexts” and click on “Save”, or go to menu “File”, select “Save” and click on 
“Snapshot”. 

   
Then, the behaviour is “Word-like”. This means that if this is the first time you save this snapshot, you will see 
the classic file browser to choose where to save your snapshot, whith which file name. However, if not, it will 
automaticly save in the corresponding file. If you want to save in another file, you have to go to “File” menu, 
select “Save As” and click on “Snapshot”, or go to “Snapshots” menu and click on “Save As” 
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7. Favorites 
Bensikin manages a list of favorites context, so you can quickly switch to anyone of them. Those favorites are saved 
on application shutdown and loaded on startup. 

7.1. Adding a context to favorites 
To add a context to your favorites, have your context ready by creating or loading it. Then go to “Favorites” menu 
and click on “Add selected context”. 

 
 

7.2. Switching to a context in favorites 
To switch to a context in favorites, which means to load it from favorites, Go to Favorites” menu, select 
“contexts”, and click on the context you want to load. 
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8. Options 
Bensikin manages global options. Those options are saved on application shutdown, and loaded on startup. 
The Options menu is located in the Menu bar : Tools Options. 

 
 

8.1. Logs Options 
Choose the application’s log level.  

Verbosity ranges from DEBUG (highest) to CRITIC (lowest), at least WARNING is recommended.  
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Figure 17: Logs Options 

 
 

 

 

 

 

8.2. Application’s history save/load Options 
Define whether Bensikin has a history, ie. a persistent state when closed/reopened. 

If Yes is checked, a XML History file will be saved in Bensikin’s workspace, and on next startup the current 
Context and Snapshot will be loaded. 
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Figure 18: Save Options 

 
 

 

 

 

 

 

 

 

 

 

 

8.3. Snapshot Options 
These are the Bensikin Snapshot Options: 
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Figure 19: Snapshot Options 

 
• In the Comment Panel, you can choose to automaticly set or not a value to a new snapshot comment. This 

means, when you click on  button, the newly created snapshot will or will not have a 
pre defined comment. 

• In the Comparison Panel, you can choose wich columns you want to show/hide for every block in the 
Snapshot Comparison table. You can choose to show/hide the Difference block too (See Figure 15: 
Snapshot Comparison - full table) 

• In the Misc Panel, you can choose the column separator for your text-CSV formated tables (See Figure 
16: Snapshot Edit Clipboard Dialog) 

 
 
 
 
 
 
 
 
 
 
 

 
Comment Panel 

 
Comparison Panel 

 
Misc Panel 
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8.4. Context Options 
Context options allow you to select which way you want to edit your contexts, see Figure 9: Options - Context 
Tab and the “5.1Creating a new context” section. 

 

9. The Bensikin toolbar 
The toolbar is located under the menu bar, and consists mainly of a set of shortcuts to often used functionalities. 

 
Figure 20: The Bensikin toolbar 

 
•  is a shortcut to creating a new Context 
•  is a shortcut to saving the selected Context/Snapshot into a Context/Snapshot file 
•  is a shortcut to doing a saving all opened Contexts and Snapshots 
•  is a shortcut to printing the xml representation of the current Context/Snapshot 
•  is a shortcut to removing all opened Contexts and Snapshots from display 

 
 

The toolbar


